
SmartSoft-TOF Software Release Notes 
 
___________________________________________________________________________ 
 
Release 3.6.0 – May 2025 (Win10/11; 64-Bit) 
___________________________________________________________________________ 
 
OVERVIEW 

FIB Tomography, Gun Tuning, LMIG Primary Particle Lookup Table, Bug Fixing 
 
NEW FEATURES 

Configuration 
1. LMIG Balanced Blanker: Select 733 for LMIG->Blanker. 
2. GCIB Blanker: Select Mod 891 for GCIB->GCIB Blanker. 
3. DSI Lite: Select 11-810 for LMIG->DSI. 
4. MVA Aperture for FIB standalone: Select LMIG->Aperture->MVA. 
5. FIB gun with no buncher, chicane and blanker lenses: Select Mod 885 for LMIG->Blanker and No for 

DSI. 
6. New Energy Slit Filter Option Names: Select ‘20eV, 50eV, 240eV’  or ‘5eV, 20eV, 240eV’. Default to 

‘20eV, 50eV, 240eV’ for nT2 and nT3. Default to ‘5eV, 20eV, 240eV’ for nT4. Default to ‘No’ for FIB only. 
 

UI 
7. Added right click menu to pin tabs to pin or unpin all tabs. 
8. Improved Queue Editor UI for easier navigation. 
9. Main Menu Bar>Tools>Resource Monitor…: Default to the max for Memory, Handle, and Thread 

monitors. 
10. Main Menu>View >Reset Layout: Return main view menus to their original sizes.  
11. Main Menu>Help>Contact Us…: Show contact information for PHI USA and Ulvac-Phi by default. 

SmartSoft-TOF\Contact.txt can be edited to include system or region specific information. 
12. Can now maximize sizable windows. 
13. Cleaned up header bar for LMIG-1 and LMIG-2. 
14. Added Zoom to Task button to expand the current job and highlight the current task in the Queue Editor.  
15. Added Select all/Unselect all right click option to the Queue Editor for updating job and task active 

states. 
16. Added queue validation for gun state when performing acquisition, timed sputtering, Auto-V, and Auto-

Z. 
17. Added joystick ribbon menu. 
18. Added Comment field to Data Manager ribbon menu. 
19. Added support to make sure that popup views are within the screen height. 
20. Added auto show pinnable side toolbar menus. 
21. Updated font to 9-point Segoe, which is the default font for Microsoft Windows 10/11. 
22. Moved ‘history’ section to be above ‘favorites’ section in setting combo box. 
23. Improved saving setting feedback by temporarily displaying a green thumb up glyph and changing the 

caption to ‘Saved’.  
24. Show platen information with platen image when hovering over the platen thumbnail in the bird’s eye 

view and header bar. 
25. Added New STARTUP, New SHUTDOWN, New OUTGAS SUPPLIES, and New TUNE in Queue Editor Tool 

Palette for building STARTUP, SHUTDOWN, OUTGAS SUPPLIES, and TUNE. 
 
System 
26. Support new vacuum task to do slow intro pump. 
27. Added prompt for service vacuum tasks. 



28. Changed functionality for Intro Photo Zoom mode. Zoom to current cursor position rather than last 
clicked position. 

 
Sample 
29. Added sample folder to position list. 
30. Added setting editor for stage settings. 
31. Use file explorer to open folders. 
32. Added support for Recover Platen from Arm. 

 
TOF 
33. Support FIB Tomography to create 3D images of a sample by collecting 2D FIB images by doing multiple 

layers of FIB milling acquisitions. 
34. Choose the primary particle and the spectrum/imaging mode during acquisitions to extract the LMIG 

lookup table parameters. 
35. Added editable mode for Sequencer’s Single Pulser and Multi Pulser table in service mode. 

 
Hardware 
36. Support LMIG lookup table to better manage LMIG settings by grouping parameters that are consistent 

for a primary particle into a lookup table. 
37. Support LMIG balanced blanker to minimize the energy broadening of the primary beam pulse and 

improve mass resolution. 
38. Added Lens2 Delta (V) for LMIG. 
39. Changed default tuning parameters for LMIG X/Y Steering tuning. 
40. Implemented automated melt test function to find Bi melting point. 
41. Support tuning for Gas Gun, E-Neut, GCIB, and C60. 
42. Always skip DEFAULT, PREVIOUS and INITIAL settings when tuning ion gun settings. 
43. Changed the default baud rate for 20-068 to 9600 to improve reliability. 
44. Added default neutralize setting for Gas Gun. 
45. Changed GCIB emission current readback to be positive value to match the polarity of target emission. 
46. Added V28 Isolation valve for GCIB for nanoTOF4. 
47. Changed the default value for GCIB Filament Limit (A) to 4.0. 
48. Support Faraday Cup deflection as percentage in Cesium Microbeam gun for ease of use. 
49. Changed default com port number for LMIG-2 deflection from 33 to 36. 
50. Show estimated time for each outgas device. 
51. Improved the readability for outgas preview. 

 
BUG FIXES 

UI 
52. Main Menu Bar>File>Save System Parameters: Fixed Auto Save parameters reverting to Never Save. 
53. Fixed an issue where SmartSoft shows up off screen on startup. 
54. Fixed a bug causing Invalid Window Handle error on shutdown. 
55. Improved application log backups. 
56. SmartSoft will no longer take focus away from currently selected UI control when mousing over the 

Intro Photo or SED image. 
57. Mouse wheeling up/down to change a value will now be applied to whichever UI control the mouse is 

hovering over, rather than the currently selected control. 
58. Improve Z ordering of windows to fix issues caused by hidden prompt dialogs locking up the UI. 
59. Cleaned up the display of the setup tab UI in Chart Recorder. 
60. Allow all user levels to overwrite DEFAULT and PREVIOUS reserved settings. 
61. Fixed the list of devices shown in Instrument Load. 

 
System 
62. Fixed an issue where platen settings would be lost on restart. 



63. Fixed access violation at startup if SmartWatcher is not installed for nT3, nT3+ and nT4. 
 
Sample 
64. Changed the wording of the auto pinning procedure to be more specific. 
65. Fixed pressure readback for Cesium Microbeam gun in bird’s eye view. 
66. Added missing platen types for nT3, and nT3+. 
67. Fixed the schematic overlay drawing for 75mm Hot platen, 75mm Hot Cold platen, 100mm BackMount 

platen, and 100mm FrontMount platen for nT3, and nT3+. 
68. Allow switching target station of Hot Cold Stage when temperature control is off. This will allow reading 

temperature from all target stations when temperature control is off. 
69. Fixed the problem that Hot Cold Stage’s Temperature is not recorded in Chart Recorder. 

 
TOF 
70. Phased Profile: Reduce a small amount of deadtime between the sputter phase and charge 

comp/acquisition phase.  
71. Corrected the issue where an incorrect LMIG setting is applied when running a phased profile with LMIG 

set as the sputter gun while logged in at the user level. 
72. Fixed premature stop of phased profile at the second cycle with pulsed ion neutralization in analysis 

phase, no neutralization in sputter phrase and active charge comp phase. 
73. Fixed transfer lens voltage value used in Auto-Z in negative polarity. 
74. Removed fast scan rate value of 4.0 MHz for SED to avoid lockup. 
75. Fixed the problem that SED photo resolution cannot be changed. 
76. Fixed LMIG aperture name became blank when running phased profile. 
77. Revised FIB Fiducial estimation time calculation to exclude beam size in the equation. 
78. Fixed error with Ion Neutralizer when enabling/disabling/resetting Card Rack Power. 

 
Hardware 
79. Only ramp Gas Gun emission when filament is cold and coming from Off mode. 
80. Added setting of Frit Power and Oven Temperature for Cesium Microbeam gun at startup. 
81. Changed the threshold for LMIG filament lifetime counting to 0.2 uA emission current because of noise 

issue. 
82. Reset Outgas Supply if outgas procedure is aborted. 
83. Allow for easier aborting of Ion Gun tuning by clicking the tune button while tuning running. 
84. Fixed an issue where the queue would hang if Ion Gun tuning validation failed. 
85. Added saving of ion gun sample current readback to SEE database. 
86. Do not show LMIG emission warning when LMIG is off. 

 
___________________________________________________________________________ 
 
Release 3.5.3 – May 2024 (Win10/11; 64-Bit) 
___________________________________________________________________________ 
 
OVERVIEW 

Allow Hot Platen to run at Higher Temperature 
 

BUG FIXES 
 
Sample 
1. Stage>Hot Cold 20-311B: Add a new property called Hot Stage Max Temperature(C) that defaults to 

600. Please edit C:\SmartSoft-TOF\Setting\Hot Cold Stage\Properties\Properties.phi to increase the 
maximum temperature value. 



2. Stage>Hot Cold 20-311B: Add a new setting parameter called Max Heater Current(A). Maximum heater 
current value is used when PID power output is 100%. 

 
___________________________________________________________________________ 
 
Release 3.5.2 – February 2024 (Win10/11; 64-Bit) 
___________________________________________________________________________ 
 
OVERVIEW 

Bug Fixing 
 

BUG FIXES 
 
Sample 
1. For the nanoTOF3 systems, check arm extension position before opening or closing intro gate valve to 

avoid damage to the arm extension robot during sample transfer. 
 
___________________________________________________________________________ 
 
Release 3.5.1 – December 2023 (Win10/11; 64-Bit) 
___________________________________________________________________________ 
 
OVERVIEW 

Support new CD aperture size; Bug Fixing 
 
NEW FEATURES 

Configuration 
1. CD Aperture: Add the support for 2 Size or 3 Size option in Vacuum Configuration. The 3 Size option is 

for nanoTOF3 systems. 
 
Hardware 
2. New CD aperture size: For the nanoTOF3 systems, there are three options of aperture sizes.  They are 

Large (2mm), Medium (400um) and Small (200 um). 
 
BUG FIXES 

TOF 
3. Auto-Z: Set Auto-Z’s maximum Z height based on user entered platen Z height max and hardware limit. 

The Auto-Z’s maximum Z height is updated with platen change on the stage. 
4. Detector Camera: Correct the problem so the V8 valve tool button will toggle the state of V8. 

 
Hardware 
5. C60: Add retry when reading filament current to improve the robustness. 

 
Service 
6. CommChecker.exe: General operation improvement. 

 
___________________________________________________________________________ 
 
Release 3.5.0 – September 2023 (Win10/11; 64-Bit) 
___________________________________________________________________________ 
 
OVERVIEW 



Automated Analysis (Queue), Sputter Beam Alignment, New 06-680 Cs, Sputter Dose Calculation, New 
Header Bar, Windows 11 Support; Bug Fixing 

 
NEW FEATURES 

Installation 
1. A batch file to do weekly settings backup is installed and added to Task Scheduler to be run every 

Sunday at 3AM. The backup schedule can be modified by using Task Scheduler. The backup settings 
are compressed and saved in C:\SmartSoft-TOF\SettingsBackup. 

 
Configuration 
2. Cesium: Add the support for 06-680. This is for the nanoTOF3 system. 
3. System>MS2>Picker Blanker Selector: Add the support for Fixed which allows unlimited number of 

blanking peaks when running non-MS2 and MS2 acquisition. ‘No’ has been renamed to ‘Manual’, and 
‘Yes’ has been renamed to ‘Selectable’ for a pneumatic precursor selector that is moved to either 
precursor position or blanker position. 

4. System>Options: SEE is defaulted to Active for sampling hardware diagnostic parameters and writing 
these system health parameters to database. 

 
SEE 
5. Disable data sampling for the respective hardware when cardrack power or motor power is disabled. 

This is to reduce the number of errors in log files that may affect performance. 
 

UI 
6. Login: Administrator password has been reset.  Please contact CS for the new default password. 
7. New Header Bar: Display current platen name, task/donut status, platen presence status/platen 

transfer, system pressures, gun status, system status indicator to alert users of warnings and errors. 
8. New Header Bar>System Status Indicator: This is the symbol in the far right of the header bar. It is used 

as an indicator for any system errors. When there is any error, the symbol will turn red with a triangular 
shape. Click on it to review errors/warnings in Application Log. 

9. Resizable Viewer Display: In the output area, provide tab pin to choose which viewer to display and 
vertical splitter to resize the width of each viewer. 

10. Menu Bar>Tools>Ammeter Tool: Add support for the 20-311B to disable the Hot/Cold stage while 
measuring current. 

11. Menu Bar>Tools>Sputter Tool> Raster Size (um): Allow custom raster size entries (not just drop down 
values). 

 
System 
12. Chamber Camera: Add 0.1, 0.2, 0.3, and 0.4 to the Zoom Factor combo box.  
13. Sample/SED/Chamber Camera Viewer: Add a Smart Toolbar button to hide and show the vertical smart 

toolbar. 
14. Sample Transfer: After platen is transferred to stage, update the platen on stage to be the current 

platen. 
 

Sample 
15. Auto-V: Automated sample bias adjustment. This can be run manually or selected to run before 

acquisition in Queue for automated analysis. Auto-V can be customized with its properties. 
16. Position List>Alignment>Auto Alignment: Run automated routine to guide users to set up 3-points 

alignment. 
 

TOF 
17. Spectrum/Phased Profile/Interleaved Profile: Support one-button queue acquisition support with the 

option of moving Platen to Stage, running multiple analysis points defined in Position List, running Bi-
Polarity, Auto-Z, and Auto-V. 



18. Spectrum/Phased Profile/Interleaved Profile/Map>Properties>Queue: Provide options for adding 
acquisition to queue. 

19. Phased/Interleaved Profile and Sputter Tool: Add the option to base sputter time off time or dose. For 
interleaved profile, sputter dose is read-only. 

20. Phased Profile>Sputter Phase>Raster Size (um): Allow custom raster size entries. 
21. Data Manager>Sample>Sample Thickness: Sample thickness can be different among multiple samples 

but should be uniform across a single sample (within 0.5 mm). Please specify sample thickness for 
each sample except for Back_Mount platen type. Drop Z is default to 2 mm. When creating a point in 
the position list, the default Z height = Max Z height – Sample Thickness – Z Drop. Default Z is only for 
nanoTOF 3/3+ systems. Current Z height is used when creating a point in the position list for nanoTOF II 
systems. 
 

Hardware 
22. Support Sputter Beam Alignment: Coordinate with TOF-DR to receive position to offset sputter beam 

set in Sputter Tool. Apply a feature raster offset when aligning sputter beam (same for primary beam 
alignment) as to not overwrite and lose tuned raster offsets. Add additional protection when saving gun 
settings. 

23. LMIG>Properties>Bi Source>Shutdown>Keep Tip Warm: Allow the Keep Tip Warm feature running when 
exiting SmartSoft. 

24. LMIG>Properties>Bi Source>Shutdown>Keep Tip Warm: The Keep Tip Warm Heater Current tracks Bi 
Emitter Startup Normal Heater Current. Keep Tip Warm Heater Current = Bi Emitter Startup Normal 
Heater Current –Heater Current Delta. Heater Current Delta is default to 0.3. 

25. LMIG>Properties>Bi Source>Recover: Modify the recover procedure by not resetting the heater current 
to normal value of Bi emitter startup. Instead update the Normal Heater Current value of Bi emitter 
startup to the new heater current value resulted from successful Refresh. The new normal heater 
current value will be used in subsequent Bi emitter startup. New default values are used for Bi Emitter 
Refresh. 

26. E-Neut: Support BaO, Ta, and Y2O3 as filament type. Support different sets of Standby Filament 
Current, Software Limit, and Cathode Work Function for each filament type. 

27. GCIB: Add a readback for emission current in main UI. Can select the update frequency. 
28. Outgas>GCIB: Improve the outgas routine to reduce the time for doing outgas. 
29. Outgas>20-311B Hot/Cold Stage: Add outgas support. 
30. Outgas>06-680: Add outgas support. 

 
Simulator 
31. Motor: Support simulation for each motor axis. 

 
 
BUG FIXES 

UI 
32. Menu Bar>Hardware>Bake>Correct the problem that the temperature is not read from the correct zone 

in the bake report. 
33. Tools>Sputter Tool: Add checking to protect against using the same gun for sputtering and ion 

neutralize. 
 

System 
34. USB Cameral: Support the correct range for Hue for the DFK 42AUC03 model. 
35. Intro Photo: Fix take intro photo problem for GigE camera when LED Lights is selected to be auto on. 
 
Sample 
36. Position List>Alignment: Correct the issue that the alignment points are changed after restarting 

SmartSoft-TOF. 
37. Stage>Diagnostics: Fix the Enabled status readback for each axis. 



38. Stage>Diagnostics: Fix ‘Set Position’ to update the motor axis drive position. Change precision of 
Position readback to three decimal points. 

39. Stage>Hot/Cold Stage: Correct the maximum temperature for 726A Hot/Cold platen to 150 degree 
Celsius. 
 

TOF 
40. Phased Profile: Reduce a small amount of deadtime between the sputter phase and charge 

comp/acquisition phase.  
 

Hardware 
41. Startup: Report any communication errors with hardware when SmartSoft starts up. Previously not all 

the errors are displayed but only logged in the system log file. 
42. LMIG: Correct the PHI LMIG’s Filament Lifetime log to log readback instead of setpoint for heater 

current and extractor voltage.  The log file is located at C:\SmartSoft-TOF\Setting\PHI 
LMIG\Logs\Filament Lifetime.phi. 

43. E-Neut>Correct the calculation of Bias value to make sure it is at least zero. 
44. Gas Gun>Correct the problem that emission is set to target value before ramping emission. 
45. Fixed the Condenser, Objective, and Bend were not correctly synchronized in terms of percentage and 

voltage. 
 
___________________________________________________________________________ 
 
Release 3.4.1 – June 2022 (Win10; 64-Bit) 
___________________________________________________________________________ 
 
OVERVIEW 

Bug Fixing 
 
NEW FEATURES 

Configuration 
1. Intro Chamber>Intro Camera: Add the support for Imaging Source GigE camera.  
2. Intro Chamber>Intro Hatch Sensor: The intro hatch door hardware sensor is an option. 
 
System 
3. Vacuum: Support new vacuum tasks for the nanoTOF 3 system. These vacuum tasks are PumpGasLine, 

ShutdownSystem, StartupSystem, and TransferVessel. 
4. Vacuum>Properties: For the nanoTOF 3 system, add Intro Pressure Setpoint for Pump Intro. 

 
Sample 
5. Stage>Hot Cold: Add a temperature readback button to support read once and periodic continuous 

read. 
6. State>Hot Cold: Add a protection to disable the relay box to H/C when software lose communication to 

the 20-311B controller. This is to prevent the sample holder from overheating. 
7. Stage: Reduce the back up limit for X and Y axis to 1 mm to increase the X and Y axis range. 

 
TOF 
8. Data Manager>Sample: Support different Max Z Height default values for the Top_Mount, Back_Mount, 

High_Temp, Hot_Cold, and 75_mm platens for the nanoTOF 3 system. 
 

Hardware 
9. Cs>Schematic: Update the schematic diagram. 

 



BUG FIXES 
System 
10. Sample Transfer: Correct a display problem that the Stage Ribbon menu remains dithered after sample 

transfer is complete. 
11. Sample Transfer: For the nanoTOF 3 system, add a five second delay after a platen is detected at the 

intro station before taking photo. 
12. Intro Photo>Properties>GigE Properties: LED Lights: This is not supported for the nanoTOF 3 system. 

LED Lights controls are dithered for the nanoTOF 3 system. 
 
Sample 
13. Stage: Correct a potential tilt axis crash problem by enhancing the stage initialization sequence.  
14. Stage>Diagnostics>Diagnostics-2: Limit Z height to 20 mm for stage exercise routine. 
15. Stage>Hot Cold: With the 20-311B Hot Cold Stage, correct a problem that the sample bias may be set 

to high voltage before disabling the relay box when starting up acquisitions. 
16. Stage>Hot Cold: Correct a problem that the range for Temperature (C) is not set correctly based on the 

H/C platen type at the H/C Target Station. 
17. Stage>Hot Cold>Properties: Increase the maximum value for PID Integral from 100 to 999.9. 
18. Stage>Hot Cold>Diagnostics: Correct a problem that H/C Target Station is not updated. 

 
___________________________________________________________________________ 

 
Release 3.4.0 – October 2021 (Win10; 64-Bit) 
___________________________________________________________________________ 
 
OVERVIEW 

New nanoTOF 3 system type; 06-360P Pulsed Ion Gun; Bug Fixing 
 
NEW FEATURES 

Installation 
1. Automatic startup of the Configuration Setup application. Please select ‘Save’ after confirming 

configuration to make sure all the appropriate setting files will be set up correctly. 
 

Configuration 
2. System: Add the support for nanoTOF3.  
3. System>MS2>MS2 Picker Lookup Table: This allows the use of a lookup table to correct non-linearity. If 

‘Yes’ is selected for MS2 Picker Lookup Table, please place your copy of PickerLookupTable.csv in the 
C:\SmartSoft-TOF\Configuration folder. 

4. Stage>Hot Cold Stage: Add 20-311B for nanoTOF3. Please re-select your option. 
5. E-Gun Neutralizer: Add E-Neut Filament. The options are BaO, Ta, and Y2O3. Please select the correct 

filament type so the appropriate outgas routine will be performed. 
6. Gas Gun: Add the support for 06-360P. The new combination of pulsed low-energy electrons and low-

energy Ar+ ions provide turn-key insulator analysis in both positive and negative ion polarities. 
7. Gas Gun>Gas Gun Control: Add the support for 20-068. 

 
SEE 
8. Sample and write consumable parameters like ion gun filament usage to the SEE database. 
 
UI 
9. New show/hide support with +/- buttons to customize the number of parameters to display. 
10. Ribbon>Queue>Queue Editor: Remove the obsolete ‘AutoTool Task’ view. Use Queue 

Editor>Utilities>Add Task… to add queue tasks. 
11. Ribbon>Queue>Queue Editor: Add the support for position list, data manager, and acquisition types.  



12. Ribbon>Queue>Queue Editor>Utilities>Sleep Until: The Sleep Until task allows the selection of a date 
and time to start the next queue task. 

13. Ribbon>Image Tool>Pulsed: Support pulsed imaging for Cesium and 06-360P Gas Gun. The resolution 
and scan rate for pulsed imaging can be adjusted in the Image Tool>Properties tab. 

14. Ribbon>Ammeter Tool>Picoammeter Range: Add selection of picoammeter range. 
15. Ribbon>Vacuum: Display only Intro and Main pressures. 
16. Ribbon>Stage: Add Absolute and Relative mode. 
 
Sample 
17. Auto Z: Streamline Auto Z setup by sharing acquisition setup like mass range and neutralization with 

main acquisitions. Provide the support for lower resolution to run Auto Z faster with one frame to 
improve the throughput. Provide the control of Transfer Lens voltage to have the analyzer cone 
contained within the field of view and centered. Display Auto Z dialog to show its image when Auto Z is 
launched. Added a new Centroid Algorithm for Weighted Average to use image moments calculation to 
improve accuracy in locating centroid. 

18. Stage>Properties>Limits: Show Platen: Max Z (mm) and Z (mm): Min/Max for Software and Hardware all 
in one place. 

 
TOF 
19. Profile>Interleaved: Support Gas Gun if the gas gun configuration is 06-360P. 

 
Hardware 
20. LMIG>Properties>LMIG Bi Source>Shutdown>Keep Tip Warm: The Keep Tip Warm mode is intended for 

reducing the emitter startup time by keeping the heater current at a warm value instead of zero when 
switching the LMIG mode from Ready to Standby. The hold time for Keep Tip Warm mode after setting 
heater current in emitter startup is much shorter than the regular hold time. ‘Warm Heater Current (A)’ 
specifies the heater current for the Keep Tip Warm mode. ‘Keep Warm Time (hr)’ specifies the timeout 
value before shutting down the tip to zero heater current. Switching the LMIG mode from Keep Tip 
Warm Standby to Off will run the shutdown routine to set the heater current to zero and take LMIG out 
from the keep tip warm mode. 

21. LMIG>Properties>Bi Recover…>Recover>Off Axis Test: Improve off axis test routine by waiting for 
emission current to reach within tolerance before averaging multiple sample current readings to 
improve accuracy and efficiency.  

22. LMIG>Properties>Bi Recover…>Recover>When Over Extraction or Refresh does not work, get out from 
the sequence without waiting for step 3a and step 3b when Stop is selected. 

23. LMIG: Add Raster Offset X/Y (um) for easy access. Support tuning for Lens 1 (V) and Beam Steering X/Y. 
For Bi source, set the lower limit for Lens 1 (V) to -10000.0 for protection. 

24. Cesium: Add Raster Offset X/Y (um) for easy access. 
25. C60: Add Raster Offset X/Y (um) for easy access. 
26. E-Neut: Add Ramp Rate (A/s) as part of E-Neut setting. Please resave all your E-Neut settings with an 

appropriate ramp rate. Implement different E-Neut outgas sequences based on the filament type. 
27. Gas Gun>Beam Energy: Add Raster Offset X/Y (um) for easy access. For the 06-360P configuration, limit 

the Beam Energy (kV) to 3kV and provide arc counts support in Diagnostics. 
28. GCIB: Add Raster Offset X/Y (um) for easy access. 

 
BUG FIXES 

Installation 
29. Correct the problem of running Custom Action multiple times when attempting to fix installation 

problem. 
 

Sample 
30. Auto Z: Correct the problem that the Auto Z state is stuck in running if Auto Z is selected again while it is 

in progress. 



 
TOF 
31. Phased Profile: Improve the robustness of using Cesium as the sputter gun by adding retry. 
32. Phased Profile: Correct a potential hanging problem of five minutes if stopping the phased profile 

during the sputter phase. 
 

Hardware 
33. LMIG>Properties>Bi Recover…>Refresh: For existing systems, please exit SmartSoft-TOF and modify 

C:\SmartSoft-TOF\Setting\PHI LMIG\Properties\Properties.phi as follows: 
Bi Emitter Over Extraction - Max Wait Time For Extractor Voltage (sec)=300  
Bi Emitter Over Extraction - Step 3 Emission Lock Max Extractor Ramp Time (sec)=300 

34. Cesium>Correct the logic to keep Cesium in Ready instead of Standby mode to keep it warm. 
35. E-Neut: Set the Standby mode filament current setpoint correctly using filament type. Set the setpoint 

to 0.9 A for BaO and Y2O3, and 1.2A For Ta. 
36. Gas Gun: Correct the problem that acquisition with neutralization is started before the emission 

current of gas gun is done ramping if the gas gun mode was off before starting acquisition. 
37. GCIB>Correct the problem that raster is turned off before completing blanking the gun. 
38. Firmware Wobble>Correct the problem that amplitude change is not applied in real time during 

wobbling. 
 
___________________________________________________________________________ 

 
Release 3.3.1 – July 2021 (Win10; 64-Bit) 
___________________________________________________________________________ 
 
OVERVIEW 

New Detector camera support; Bug Fixing 
 
NEW FEATURES 

 
UI 
1. Menu Bar>Hardware>System Configuration>Detector Camera: Add support for DMK22AUC03.  
2. Menu Bar>Hardware>System Configuration>System>MSMS>MS2 Detector Camera: Add support for 

DMK22AUC03.  
3. Configuration>Support customizable system name. 
 
TOF 
4. Acquisition>MS/MS: The lower limit for Precursor Mass (amu) is default to 80 amu. It can be set to 

between 68 amu and 80 amu. Please note that 80 amu was used to test electronics. 
5. Acquisition>End Mass (amu): The lower limit is changed to 100 amu. 

 
Hardware 
6. C60>Properties>Column: Add Stigmator Angle for adjusting rotation for optimization. 
7. C60>Properties>Column: Open the range for Stigmator Amplitude (V) to [-200, 200]. 

 
BUG FIXES 

TOF 
8. Chamber Camera: For DFK42AUC03, default video format to 'BY8 (1280x960)'; and frame rate to 25.10'. 

Correct the problem that the chamber camera properties are not persisted after each SmartSoft 
session. 

9. Detector Camera: Correct the problem that the detector camera parameters are not persisted after 
each SmartSoft session. 



10. MSMS Detector Camera: Correct the problem that the MSMS detector camera parameters are not 
persisted after each SmartSoft session. 

 
 

Hardware 
11. Vacuum: Improve SVC reliability by adding recovery routine to address response mismatch issue. 

 
 
___________________________________________________________________________ 
 
Release 3.3.0 – August 2020 (Win10; 64-Bit) 
___________________________________________________________________________ 
 
OVERVIEW 

Queue Editor Tool Palette; Bug Fixing  
 
NEW FEATURES 

UI 
1. Ribbon>Tool: Provide access to Queue and Queue Status. 
2. Ribbon>Tool: Make Vacuum Ribbon more compact to save space. 
3. Menu Bar>Automation>Queue Editor…: Rename AutoTool to Queue Editor. Add Tool Palette for simple 

utilities and hardware startup, shutdown, and outgas. 
4. Prompt for setting Cesium to Standby Mode at Startup: Give user the option to keep Cesium at Standby 

or switch to Off mode. If Standby mode is selected, PREVIOUS setting will be loaded. If Off mode is 
selected, ZERO setting will be loaded.  

 
System 
5. Vacuum>Improve pressure readback display to save space. 

 
Hardware 
6. Analyzer>MS2>Properties>Flight Time Calib: Change the calculation of Precursor start and end time in 

the Sequencer timing. Shift the time by half of Precursor Diff Offset (us). This change is backward 
compatible with V3.2.1 or earlier version of MS2 setting files. 

 
Installation 
7. Always use WinUSB drivers for USB devices. 
8. Provide a digitally signed WinUSB driver for PHI devices. Improve robustness of system setup by 

automatically installing this driver when installing SmartSoft-TOF. 
9. Report any installation problems including component registration by displaying Custom Actions log 

file when failure occurs. 
 

BUG FIXES 
 
PHI-FIB Configuration 
10. Correct the problem that PHI-FIB system hangs at start up. 
 
UI 
11. Ribbon>Tool: Do not change SED gain to target value when selecting tuning while imaging.  
12. Correct screen flickering that occurs when window group policies are being updated.  

 
System 
13. System>Sample Transfer: Remove Y axis limit validation for intro sample task or subtasks. Y is expected 

to move, and it should not prevent users from performing intro sample task. 



 
Hardware 
14. LMIG>Properties>Column: Correct the problem that Lens2 (V) DC cannot be edited at User level. 
15. LMIG>Tuning… button: Correct the problem that the Tuning button stays pressed after selection. 
16. LMIG>Tuning… button: Correct the problem that a warning dialog is always displayed when selecting 

the Tuning button while source tuning is running. 
17. Cesium>Properties>Raster: Add the missing Raster Size and Offsets X/Y. 

 
___________________________________________________________________________ 
 
Release 3.2.1 – January 2020 (Win10; 64-Bit) 
___________________________________________________________________________ 
 
OVERVIEW 

Bug Fixing  
 

BUG FIXES 
 
TOF 
1. Phased Profile: When LMIG is selected as both the Primary Gun and Sputter Gun with the Use Settings 

option, correct the problem that Lens 2 voltage is set to zero when sputtering. 
2. SED Image Viewer: Correct the problem that Center Marker is not displayed regardless of its selection 

in the Image Properties. 
 

Hardware 
3. Outgas>Gas Gun: Correct the problem that emission current is not ramped if Gas Gun mode is Off 

when starting outgas. 
 
___________________________________________________________________________ 
 
Release 3.2.0 – October 2019 (Win10; 64-Bit) 
___________________________________________________________________________ 
 
OVERVIEW 

Ribbon; Outgas Improvements; LMIG Tuning Tool; Bug Fixing  
 
NEW FEATURES 

UI 
46. Ribbon>Tool: Able to access Acq Status UI from Ribbon for optimized window layout. 
47. Ribbon>Tool: Provide access to Tuning Tool for LMIG and LMIG-2. 
48. Ribbon>By default, Ribbon is enabled with V3.2.0 software installation. 
49. Ribbon>Filament Usage: Provide a birdeye view of various consumptable usage like filament using 

battery views for maintenance cue. 
50. Menu Bar>Hardware>System Configuration>LMIG-2>Spectroscopy: Specify if LMIG-2 can be used as a 

spectroscopy gun. A second blanker/buncher box is required for the spectroscopy function.  
51. Menu Bar>Hardware>Open System Log…>Log File Analyzer: Provide a new option to update the log 

content periodically. 
52. Menu Bar>Automation>AutoTool…: Add Queue tree view to show startup, shutdown, and outgas 

sequence with limited editing functionality.  
53. Menu Bar>System>Zip Log File…: Have the option to include the last ten days of SEE data in the zip file. 



54. Prompt for setting GCIB to Standby Mode at Startup: Give user the option to bring up GCIB at Standby or 
Off mode. If Standby mode is selected, PREVIOUS setting will be loaded. If Off mode is selected, ZERO 
setting will be loaded.  

55. Prompt for confirming trace logging levels set to higher than the default level. This is to avoid excessive 
logging that is caused by a previous debugging session. 

 
System 
56. Vacuum>For systems with the LMIG-2 configuration, close the LMIG-2 Isolation Valve at Exit. 
57. Vacuum: Display a pressure readback as dashes instead of error when gauge or convectron readback 

has become out of range. 
58. Position List: Default Z height to 0.001 when positions are created on platen in Intro. 
59. USB Connection Monitor Support: Monitor and log messages in the system log when USB device is 

disconnected or connected. This is to differentiate the source of problems when communication errors 
occur. USB disconnect/connect indicate non-controller issues. 

 
TOF 
60. SED Image Viewer & Chamber Camera Viewer: Add “Lock” button to prevent unintended stage move 

when not running SED. The “Lock” button can be manually toggled to override the default behavior. 
 

Hardware 
61. Outgas Conditioning>Improve outgas with the following features: 

• Gauge selection – select the appropriate gauge for monitoring pressure 
• Recovery pressure – wait until pressure drops below this pressure before resuming outgas after 

pressure raises above the threshold pressure and reduction has to be performed 
• Hold time – specify the additional wait time after a supply outgas is complete 
• Details… button – show a preview for all the outgas parameters setup for the gun selected 
• Chart Recorder launch – automate the launching of chart recorder and saving of chart recorder 

outgas data 
• New Queue tree view display of outgas recipe in AutoTool – view outgas sequence and uncheck 

any unwanted outgas tasks 
• Improved outgas sequence with more automated support 

 
62. Auto Shutdown>Standardize auto shutdown for GCIB, Gas Gun, Ion Neut, E-Neut, C60, and Cesium. 

GCIB, Ion Neut, E-Neut, and Cesium support “Ready to Standby” and “Standby to Off”. 
Gas Gun supports “Ready to PARK” and “PARK to Off”. PARK means Standby mode with no emission 
and no gas. 
C60 supports “Ready to Standby”, “Standby to Idle”, and “Idle to Off”. 

63. LMIG>Tuning…: The tuning tool is for optimizing Beam Steering X/Y by centering the LMIG column image 
and optimizing Lens1 (V) by minimizing the size and sharpening the edges of the image in the SED 
Viewer. In the normal operation mode (i.e., not tuning), Beam Raster (%) is set to zero and only the 
Beam Steering X/Y values are applied to the gun. Users can launch the tuning by selecting the Tune 
button. In starting tuning, Beam Raster (%) will automatically be set based on the current LMIG raster 
size (% = 4000 / Raster Size (um)), raster waveforms are added to the steering values, and SED will be 
started. This feature requires jumper change in the 781 Deflection to apply raster waveform to the Quad 
Output connects used for source X/Y steering. 

64. LMIG>Properties…>Column: Add Lens 2 (V) DC setting parameter. The Lens 2 voltage is automatically 
set to the DC value when LMIG is in DC mode when performing SED, sputtering, and current reading. 

65. LMIG>MVA: Add “Industrial” and “FIB” options for Aperture Style. 
66. GCIB>If GCIB is not Off, set mode to Standby at exit to keep emission current and ionization voltage 

stable. 
67. E-Neut>Emission Current Readback: Display emission current readback in the main E-Neut UI. The 

reading interval can be adjusted. 



68. E-Neut>Diagnostics: Provide additional ADC readbacks. 
69. Gas Gun>Emission Current Readback: Display emission current readback in the main Gas Gun UI 

instead of showing Target Emission set point. The reading interval can be adjusted. 
70. Gas Gun>Diagnostics>20-066: Correct the unit for Filament Current readback to A. 
71. Analyzer>Analyzer>Sample Bias Voltage: Add wobble support. 

 
BUG FIXES 

 
Installation 
72. Correct the 64-bit installation that the wrong version of msvcrp100.dll and msvcr100.dll are included 

that may cause USB Cameras not functioning. 
 

System 
73. System>Intro Photo: Correct the problem where “GigE Camera” is displayed as the caption although 

the system is configured to have a Canon camera. 
 

Hardware 
74. LMIG: When there is a DSI shutdown event in bringing up SmartSoft-TOF, correct the problem that 

supplies do not remain as zero when loading a non-ZERO setting and LMIG mode is off after fixing DSI 
shutdown. 

75. LMIG>Properties>Column: Correct the problem that Raster X and Y Offset (um) are saved as zero in 
Beam Steering Raster mode (i.e., Beam Steering Raster (%) <> 0) when saving LMIG setting. 

76. LMIG>Diagnostics>General: Correct the problem that 10V Ref (V) is not updated unless SEE Database 
is activated. 

77. E-Neut>Remove target Emission (uA) to avoid confusion as E-Neut is run in manual emission mode by 
adjusting Filament (A). 

78. RBD Picoammeter Communication Problem: Correct the problem that prior USB power loss may cause 
SmartSoft-TOF unable to start with RBD communication problems. 
  

KNOWN ISSUES  
79. AutoTool Setting files generated by previous versions of SmartSoft-TOF are no longer compatible with 

the V3.2.0 software. Please take screen shot of the AutoTool setting files before installing V3.2.0 and 
regenerate them in V3.2.0. Please use AutoTool>Create>SHUTDOWN/STARTUP to regenerate the 
shutdown and startup sequence. 

80. Please re-set up your auto shutdown option for GCIB, Gas Gun, Ion Neut, E-Neut, C60, and Cesium as 
the options have changed. 

 
___________________________________________________________________________ 
 
Release 2.7.0 – October 2018 (Win7; 32-Bit) 
Release 3.1.0 – October 2018 (Win10; 64-Bit) 
___________________________________________________________________________ 
 
OVERVIEW 

SEE database diagnosis; New LMIG Bi-Single tip with improved Bi Startup routine; Bug Fixing  
 
NEW FEATURES 

SEE 
1. SEE: The System Evaluation Environment (SEE) is a new service utility built into the SmartSoft software 

which periodically records all system parameters while SmartSoft is running.   
Notes: By default, this utility is not active; and proprietary analytical data is never collected with SEE.  

2. Menu Bar>Hardware>System Configuration>System…>SEE: SEE data collection can be fully activated 
or deactivated in the configuration menu. 



3. Menu Bar>Hardware>System Log Setup…>Data Sampling: SEE data collection can be partially 
activated or deactivated for individual hardware devices by selecting Data Sampling.  Note that Data 
Sampling for individual devices is only valid when SEE data collection is activated in the System 
Configuration.  

 
UI 
4. Menu Bar>Hardware>Chart Recorder…: The Chart Recorder now includes an ‘Auto Scale’ feature which 

optimizes the data displays for all plots. 
5. Menu Bar>Hardware>Resource Monitor…: Add monitoring of C: hard disk space.  A warning message is 

displayed when the available disk space falls below an enterable threshold value. 
6. Menu Bar>System>Task Scheduler…: A ‘Once’ checkbox option is added to the task scheduler to limit 

the processing of the task to run only one time. 
7. Menu Bar>Hardware>Test Hardware…>: Auto fill the appropriate command options based on the 

selected device name to improve usability. Device command info is reformatted to improve readability. 
8. Menu Bar>Hardware>System Configuration>LMIG-1/LMIG-2>Emitter Type: Support new Bi-Single tip.  
9. Tool Window Dashboard: Able to access UI for Vacuum, Joystick, Stage, Image Tool, Ammeter Tool, and 

Sputter Tool anytime. 
10. Prompt for setting C60 to Idle Mode at Startup: Give user the option to bring up C60 at Off mode. 
11. Prompt for running Shutdown sequence: Give user the option to cancel any unintended shutdown. 
 
System 
12. USB Camera Model>Add support for DFK 42AUC03 UBS. 

 
TOF 
13. Phased Profile: Allow I-Neut for the charge comp phase and the sputter phase if sputtering at ground. 
14. Data Manage>Lab Book: The lab book can now include an unlimited number for data file entries.  

Previous limit was 150. 
 

Hardware 
15. DSI>Shutdown: Display additional information including ADC index, actual value, and expected value 

for easier problem diagnosis. 
16. MS2>Shutdown: Display additional information including ADC index, actual value, and expected value 

for easier problem diagnosis. 
17. LMIG-1/LMIG-2>New Bi-Single tip: For Bi-Single tip with 20-751, it runs emitter startup with controlled 

over extract to correct any off-axis problem. If emitter startup fails, it extends the waiting period to 60 
minutes before automatically shutting down the tip, so users have a better chance to intervene. This is 
done by restoring the extractor current limit after 60 seconds and keep the tip in a a safer state while 
waiting. 

18. LMIG>Bi Source…>Startup>Step 1a Cold and Warm Hold Time (sec): Use different hold time depending 
on the elapsed time since last shutdown to make Bi Startup more efficient. 

19. LMIG>Bi Source…>Shutdown>Bi Warm Tip: Use this option to maintain a warm Bi heater current for an 
extended time period. 

20. LMIG-2-MVA: Add AutoTool tasks to do LMIG-2-MVA Drive All and Initialize. 
 

Service 
21. CommChecker.exe: A new utility called CommChecker is included in the SmartSoft-TOF\bin folder. 

CommChecker is used to check the communication channels as defined in the SmartSoft-TOF 
configuration properties file for trouble shooting purpose. 

 
BUG FIXES 
 
UI 
22. UI>Tab Stop: Tab stops are removed for all menus. 



23. UI>Menu Bar>System>Task Scheduler…: Fixed problem where the Task Scheduler incorrectly reports 
“AutoTool is already running”. 

24. Prompt for opening V7, V11, or V14 before operating LMIG-1, LMIG-2, or Cesium: Add the missing 
prompt for FIB, current measurement, and sputtering. 

25. Make Sample Bias selection: HV | GND| GND + Charge Comp consistent among Sputter Tool, FIB, and 
Phased Profile. 

26. File>Exit>Prompt user to confirm whether to shutdown LMIG source: Correct the problem that LMIG 
source is always shut down regardless of user response. 

 
System 
27. Sample>Position List>Z Position = 0.0: A default Z position of 0.0 indicates that the Z position is 

unknown at the time the position is created (e.g., platen not on the stage; import from defect file).  Drive 
to Position ignores the Z move when the Z position is 0.0.  SmartSoft now displays a prompt which 
clarifies that a default value of 0.0 maintains the current Z position; while a value of 0.001 drops the Z to 
a minimum Z position.  

28. System>Intro Photo>Take Intro Photo: Corrected the problem where taking intro photo is very slow and 
SmartSoft becomes unresponsive. 

29. Usb Cameras>Missing dll files: Include msvcrt100.dll and msvcp100.dll in the installation. 
 

TOF 
30. Acquisition: Correct the problem that acquisition hangs if DSI shutdown occurs during acquisition. 
31. Acquisition>Dose Calculation: Add multiplying of beam fraction to dose calculation. 
32. FIB: Do not keep toggling the LMIG Blanker Amplitude relay during the FIB routine to reduce overhead 

and unnecessary wear on the relay. 
33. Imaging: Correct the problem that restarting imaging using the Scan Speed button does not use the 

current Sample Bias Ground selection. 
34. Phased Profile: Sputter Phase>Sample Bias>GND: Correct the problem that the GND selection doesn’t 

ground the sample. 
 

Hardware 
35. Agilent Ion Pump Configuration: New channel assignment for Controller #2: LMIG-2 Source Ion Pump = 

Channel1; LMIG-2 Column Ion Pump = Channel2; Cesium Ion Pump = Channel3 
36. GCIB: Close GC0 and turn pressure control off when GCIB mode is standby or off. 
37. GCIB>Timed Sputtering: Correct timed sputtering failure if extractor voltage is greater than beam 

voltage. 
38. GCIB>Standby Mode: With PHI USA GCIB Control, correct the problem that high voltage is loaded after 

load setting. 
39. LMIG>Properties>Bi Recover…>Over Extract: Correct the problem that extractor voltage is not set back 

to nominal value at the end of the over extract procedure.  
40. LMIG>Properties>Extractor Limit (V): Correct the problem that the extractor voltage is ramped to the 

hardware limit instead of the software limit specified by Extractor Limit (V). 
41. LMIG>LMIG Properties>Column>Beam Steering Raster (%): Correct a firmware problem that sums the 

beam steering values based on the current image shift values. 
42. LMIG>Sensitivity Factor Calculation: Corrected the calculation using extractor voltage’s hardware limit 

instead of software limit.  The sensitivity factor affects the extractor voltage’s change rate in emitter 
startup. 

43. LMIG-2 Source Gamma Ion Pump Port number: Changed the port number from COM9 to COM4 to avoid 
a conflicit with Cesium port number assignment. 

44. TDC: Support the old TDC 915 model. 
 



KNOWN ISSUES AND LIMITATIONS 
45. If no Blanker/Buncher Electronics (DC FIB gun only), LMIG-2 should not be allowed as the spectroscopy 

gun to run spectral, profile, map, and image acquisition as the excessive signal can damage channel 
plates. 

 
___________________________________________________________________________ 
 
Release 2.6.2 – March 2018 (Win7; 32-Bit) 
Release 3.0.2 – March 2018 (Win10; 64-Bit) 
___________________________________________________________________________ 
 
OVERVIEW 

Support Bi Emitter Off Axis Test, Over Extraction Recovery Process, and Refresh Recovery Process.  
 

NEW FEATURES 
Hardware 
1. LMIG>Properties>Bi Source…>Recover Tab>Support Bi Emitter Off Axis Test, Over Extraction Recovery 

Process, and Refresh Recovery Process. 
 

Off Axis Test 
Preliminary assumptions: LMIG is in the READY mode and L1; X/YBeamSteering; & MVA have been 
optimized for maximum column current. This test will measure column current at a low/high Emission 
Current and report a Pass/Fail status. Pass criteria is a (minimum current) & (minimum ratio at the low/high 
Emission Current). 
 
Over Extract Recovery Process 
Preliminary assumptions: LMIG is in the READY mode and L1; X/YBeamSteering; & MVA have been 
optimized for maximum column current & the Off-Axis Test has failed. This procedure will apply a high 
Extraction Field to the Bi tip to reshape the emission point of the Bi tip. Retries will be automatically 
performed. Bi source READY operation will be re-established, and a Complete or Complete-with-failure 
status will be returned. Final Extraction Voltage operation is the criteria used to establish Recovery 
Success. 
 
Refresh Recovery Process 
Preliminary assumptions: LMIG is in the READY mode and the Over Extract has not restored normal 
operation. This Procedure will re-heat the Bi tip while under an extremely high Extraction field to reshape the 
emission point of the Bi tip. Retries will be automatically performed. Bi source READY operation will be re-
established, and a Complete or Complete-with-failure status will be returned. Final Extraction Voltage 
operation is the criteria used to establish Recovery Success. 

 
___________________________________________________________________________ 
 
Release 2.6.1 – December 2017 (Win7; 32-Bit) 
Release 3.0.1 – December 2017 (Win10; 64-Bit) 
___________________________________________________________________________ 
 
OVERVIEW 

Bug Fixing  
 
BUG FIXES 
UI 



1. Menu Bar>Hardware>Bake>Increase the maximum value for Bake Time (Hours) and Cooldown Time 
(Hours) to 200 to allow for a longer bake. 

2. Menu Bar>Hardware>Sequencer>Diagnostics>Multi Pulser>Precursor>If necessary, widen the width 
(difference between Start and Stop time) to 80 ns to protect hardware. 

3. Menu Bar>Hardware>Sequencer>Diagnostics>Lock Button: A Lock button is added to the Single and 
Multi Pulser list, which, when pressed, prevents editing. The Lock button automatically gets pressed 
when running acquisition. This is to protect hardware during acquisition. For example, switching the 
rest state for MS2Buncher or Precursor could damage Mod 794/795. 

 
System 
4. Sample Transfer>Intro>Fix the problem of introducing sample with taking intro photo with GigE camera. 

 
TOF 
5. Spectrum/Profile/Map>Precursor Mass (amu)>Change the minimum value to 80. 

 
Hardware 
6. GCIB>Standby Mode>Modify the definition of Standby mode to include blanking the beam. This 

improves the transition from Standby to Ready mode to make sure the beam is blanked before ramping 
the beam voltage. 

7. LMIG>Properties>Extractor Limit (uA)>Disable this field for 20-750. Extractor Limit (uA) is supported by 
20-751 only. 

8. LMIG>Filament Lifetime>Fix the problem of filament lifetime decreases after unexpected termination of 
SmartSoft-TOF. Filament lifeimte is logged in C:\SmartSoft-TOF\Settings\PHI LMIG\Logs\Filament 
Lifetime.phi. 

9. LMIG>Emitter Startup>Abort>Stop emission control loop when emitter startup is aborted. 
10. LMIG>Emitter Startup>Fix the problem of leaving the cursor spinning after emitter startup fails or 

aborts. 
11. LMIG>Emitter Shutdown>In shutting down, only ramp down the heater current. If Heater Shutdown 

Current is greater than the current heater current, do not perform any actions. 
12. MS2>Width Factor>Change the minimum value to 0.65. 

 
___________________________________________________________________________ 
 
Release 2.6.0 – October 2017 (Win7; 32-Bit) 
Release 3.0.0 – October 2017 (Win10; 64-Bit) 
___________________________________________________________________________ 
 
OVERVIEW 

Support for Windows 10; Agilent ion pump configuration; LMIG source bake; Integrated FIB; Dual LMIG; Bug 
Fixing  

 
NEW FEATURES 

UI 
1. Menu Bar>Hardware>System Configuration>Ion Pump: Support Agilent Ion Pump. This includes ion 

pumps for LMIG-1/LMIG-2 source, LMIG-1/LMIG-2 column, spectrometer, and Cesium source. 
2. Menu Bar>Hardware>System Configuration>Spectrometer Bypass (V12): Support pneumatic 

spectrometer bypass valve for baking LMIG source.  
3. Menu Bar>Hardware>System Configuration>LMIG-1>Bypass Valve(V13): Support pneumatic LMIG-1 

bypass valve for baking LMIG source.  
4. Menu Bar>Hardware>System Configuration>LMIG-2>Bypass Valve(V16): Support pneumatic LMIG-2 

bypass valve for baking LMIG-2 source.  



5. Menu Bar>Hardware>System Configuration>MSMS Precursor Selector: Support automated move of 
precursor selector position. It can be moved to the picker or Post ESA blanker position. 

6. Menu Bar>Hardware>System Configuration>LMIG-2 Type: Support dual LMIG. 
7. Menu Bar>System>Zip Log Files>Close down the dialog after zipping files. Reduce the key stroke as we 

usually zip up one file at a time. 
8. Service Shortcut: The installation creates a separate SmartSoft-TOF folder on the desktop and move 

the Service shortcut to this folder. A shortcut to the Configuration Setup program is also added to the 
folder. 

 
System 
9. Automation>Add MSMS V15 open/close to the startup/shutdown create sequence. 
10. Bake>Add the option to bake LMIG-1 or LMIG-2 source. This will reduce the bake time after LMIG tip 

replacement. Pneumatic V12, V13, and/or V16 bypass valves are required for LMIG source bake. 
11. Intro Glyph>Create Sample>R-Click on the Intro Glyph presents a dialog allowing the user to change 

the Sample Name. 
12. Pressure Log>Record intro, chamber, spectrometer, and LMIG pressure and write them to a file in the 

settings/log directory. 
13. Polarity Switch>Provide an action button to retry polarity switch if polarity switch fails. This also notifies 

users of any polarity switch failure. 
14. USB Camera Model>Support DFK 41BU02 in addition to DFx 41BU02. 
15. Tools>Sputter Tool>Charge Comp button and Charge Comp Properties dialog: Make it consistent with 

other tools and acquisition setups. 
 

TOF 
16. FIB>Support Integrated FIB. Support neutralization with standard Charge Comp button and Charge 

Comp Properties dialog. 
17. FIB>SED>Provide selectable green line for Mill, Polish, and Fiducial areas to reposition areas easily. 
18. FIB>SED>Context Menu>Undo (FIB): Provide an undo feature to easily correct an accidental mouse 

click on SED. 
19. Acquisition Setup>Add context menu to all start acquisition buttons to allow direct access to the Data 

Manager properties. 
20. Acquisition Setup>Charge Comp Properties>Add the option to do DC Beam Electron Neutralize in -

SIMS. 
21. Acquisition Status>Stop and Abort buttons>Update button hints to show if raw data file will be saved 

with the stop and abort actions. 
22. Start MSMS Acquisition: Provide an action button to open MSMS V15 if closed. 
 
Hardware 
23. Chart Recorder: This is a replacement for historical plot. Chart recorder supports setting files, plotting 

multiple supplies with scale factors, and customization of plot background color, line width, axes 
labels, data markers, etc. 

24. Diagnostics: Have the option of archiving periodic hardware diagnostics data for trouble shooting and 
system health check. 

25. LMIG>Bi Startup>Provide new parameters and routine for startup and shutdown. For Bi startup, add 
Step 1b and 3b. The change is backward compatible by using different parameters for different types of 
tips. 

26. LMIG>Properties>Extractor Limit (V): Move Extractor Limit (V) from Bi Startup to Properties. Use it as a 
limit for all extractor voltage input fields. 

27. LMIG>LMIG Properties>Column>Beam Steering Raster (%)>Support raster scanning of the Quadrupole 
Beam Steering X/Y plates. It controls the mag to oct ratio for the 781deflection. Please set image shift 
values to zero before modifying beam steering raster percentage. 

28. LMIG>Rename vacuum interlock to latched vacuum interlock. Latched vacuum interlock is tripped 
after vacuum interlock is fixed. 



29. LMIG>Display a dialog to notify users when vacuum interlock is tripped. Show the emission current as’-
-.--’ when interlock is tripped. 

30. LMIG>Prompt users when firmware lock is not available because of incorrect firmware version when 
SmartSoft-TOF starts up. The firmware version needs to be at least 1.3.5. 

31. Analyzer>DSI Diagnostics>Spectrometer>Hex Blanker>Clear>Add the Clear button to reset the hex 
blanker. The hex blanker needs to be reset every one to two months or when you start seeing a lot of 
TDC overflow errors. 

32. GCIB>Support Standby mode. In standby mode, all supplies are set to zero except for ionization voltage 
and emission voltage. 

33. Settings Editor>This can be used to view parameters, highlight polarity parameters, and modify 
parameters for all hardware.  

34. Copy Polarity>This can be used to copy parameters from positive polarity to negative polarity, or from 
negative polarity to positive polarity. This is supported by all hardware except for LMIG and Analyzer. 

 
BUG FIXES 
UI 
35. Menu Bar>Tools>Sputter Tool>Do not show red salient in status line when timed sputter is aborted. 

Abort is not an error. 
36. Menu Bar>System>Zip Log Files>Fix the issue of the dialog is hidden under SmartSoft-TOF main 

window. 
 

System 
37. Vacuum>Pump Intro>When there is an atmosphere leak and the pump intro task is aborted, increase 

the wait time from 5 seconds to 30 seconds to pump the high pressure out of the rough line before 
closing V6 and re-opening V5 to avoid dumping the system. 

38. Vacuum>Pump Intro>Add checking to make sure turbo is on (turbo speed > 50%) before switching to 
turbo pumping to avoid dumping the system. 

39. Vacuum>Properties>Correctly display yellow properties highlighting for “Wait Times”. 
40. Valve Viewer>ToolBar>Large Pressure Display: Add Cesium pressure to the display list. 
41. Intro Photo>GigE Camera>Fix issue with GigE camera so the camera doesn’t require ‘Device User ID’ 

set to ‘Intro’ to work. 
42. Tools>Sputter Tool>Improve error handling so it does not get stuck for five minutes when it fails to start 

E-Neut or I-Neut. 
 
Sample 
43. Chamber Camera Viewer>Chamber Camera Viewer Properties>Fix the problem of point & click’s move 

off by 90 degrees. 
44. Stage>Relative Drive Mode>Add protection to block slew moves while in relative mode. Slew moves are 

allowed only in absolute mode. 
45. Stage>Relative Drive Mode>Address the problem of not limiting Z height in relative mode and touching 

immersion lens. 
 

TOF 
46. Data Manager>Remove the limitation of 512 characters for MS1 and MS2 mass calibration peak strings 

in raw data file. 
47. Data Manager>Increase the precision for MS2 mass calibration parameters by recording these 

parameters with seven decimal point precision in the raw data file. 
48. Data Manager>MS2 Mass Calibration Peak List>Truncate peak list to only precursor mass when 

precursor mass is changed by at least 0.5 amu. 
49. Acquisition Properties>Detector Scan Mode>Use better default values.  Use Imaging 16x16 for spectral 

acquisition. Use Fast for profile and map acquisition.  
50. Acquisition Properties>Raster Pattern>Remove the 4-fold interlace patterning because of a hardware 

bug that causes missing data with the 64 and 128 resolution and 4-fold pattern. 



51. FIB>Make UI more intuitive. Dither out fields based on which mode (e.g., Mill, Polish) is selected. Add 
DC Current (nA) to FIB properties. 

52. FIB>Estimated Time: Make it more responsive and update time when FIB or FIB gun parameters change. 
 

Hardware 
53. Contention>Improve the scheme for hardware contention. This allows us to run simultaneous tasks 

more effectively (for example, running Bi startup while charting multiple hardware supplies) and have a 
more responsive UI. 

54. Analyzer>Properties>Spectrometer(S)>Post-ESA Slope: Fixed the problem of calibration when old 
analyzer setting files or raw data files are loaded with old intercept values.  

55. Analyzer>MS2>Properties>Mass Calib>Buncher (V)>Open up the range to [0, 10,000] to allow MS2 
mass calibration to work properly for all systems. 

56. LMIG>Properties>Filament Usage>Stop counting lifetime when LMIG vacuum interlock is tripped. 
When vacuum interlock is tripped, the controller returns the maximum value for emission current, 
which can greatly increase the value for Filament Usage (uA-hr). 

57. LMIG>PHI LMIG Emitter Status>Bi Startup>Correct update of readback values for suppressor and 
extractor voltages during Bi Startup.  

58. LMIG>Lens 1(V) and Lens 2 (V)>Correct the problem that lens 1 and lens 2 voltages are set to zero when 
SmartSoft-TOF starts up with firmware lock on and in -SIMS. 

59. LMIG>Diagnostics>Column>Rename Interlock Status to Sample Interlock Status. 
60. GCIB>GCIB Error>Display an error dialog to notify users of any GCIB interlocks. GCIB is turned off when 

an interlock is tripped.  
61. Gas Gun>Change emission startup dialog from Modal to Modeless so users are not locked out from the 

UI. 
62. Gas Gun>Clean up UI so the layout is consistent with other guns. 
63. Raster Size>The raster size dropdown list is now updated correctly to show the minimum and maximum 

selections for all guns. 
 
___________________________________________________________________________ 
 
Release 2.5.0 – December 2016 
___________________________________________________________________________ 
 
OVERVIEW 

SmartSoft-TOF V2.5.0:  Support 64-bit SmartSoft-TOF window program; Integrated Fast Zalar  
 
Note: This is the first version of SmartSoft-TOF that supports both 32-bit and 64-bit installations. The 64-bit 
installation takes advantage of the larger memory address space and increased RAM size.  This allows the 
SmartSoft software to better handle large data files and increased pixel display resolutions. 

 
NEW FEATURES 

UI 
1. Menu Bar>Hardware>System Configuration>Fast Zalar: Support the Fast Zalar option if the system has 

a Hot Cold Stage. 
2. Menu Bar>Hardware>Detector Calibration…>Calibration File Name: Previous invalid ‘_’, ‘+’, ‘~’ are now 

allowed. 
3. Menu Bar>Automation>AutoTool>GCIB: Close Gas Valve. Customers can close the gas valve but keep 

GCIB in ready mode to keep the beam current stable for next day. 
4. Menu Bar>System>Zip Log Files: Allow zipping of system log files from a time period with Start and End. 
5. Menu Bar>Sequencer…>Diagnostics…>Abort: Abort Data Acq and TDCs. This may help if the 

acquisition hangs. 
 

Sample 



8. Stage>Fast Zalar: Allow Start and Stop of Fast Zalar (high speed rotation) if Sample Type is Fast Zalar. 
 
TOF 
9. Data Manager>Sample>Sample Type: Added a new Sample Type called Fast Zalar. 

 
Hardware 
10. LMIG>Properties…>Bi Source: Added a new field called Extractor Voltage Limit (V) for limiting the 

extractor voltage when emission control is regulated in Step 2, Step 3, and first part of Step 4.  It is 
default to -8000 for the new Bi tip.  If you are using the old Bi tip, please set it to -12,000V for 20-750 or --
15,000V for 20-751.  The limit for hold time for Step 1, Step 2, and Step 3 is increased to 100,000 
seconds. 

 
BUG FIXES 
UI 
11. Menu Bar>Hardware>System Configuration>Intro Camera: Make it backward compatible and doesn’t 

require users to re-select Intro Camera configuration. Previous Yes | No will be remapped to Canon | 
None. 

 
System 
12. Intro Photo>Take Photo: Prevent software hang caused by Auto Focus failure. If Take Photo detects an 

Auto Focus error, it will display an error instead of proceeding and waiting forever. 
13. Intro Photo>Calibrate>Calibrate Properties>Center Calibration Position: Hook up missing callback.  
14. Vacuum>Properties>Pump Intro Wait Time: Changed the maxium wait time from 60 minutes to 24 

hours to support gassy samples. 
15. Vacuum>Properties>Transfer Sample Main and Transfer Sample Intro: Remove these parameters as 

they were not used. 
16. Vacuum>Pump Intro: Do not open V4 if Pump Intro fails and cannot reach Intro Pre-Pump pressure. 
 
TOF 
17. FIB>Abort: Fixed beam damage by waiting for the sputter process to complete before restoring 

hardware parameters. 
 
Hardware 
18. LMIG>Load Setting: Block user from loading setting when sample is at Intro, stage is busy, stage 

aperture is busy or requires initialization. 
19. LMIG>Lens 2 Steering Y: Fixed the range to -100 to +100. 
20. C60>Load Setting: Block user from load setting if aperture requires initialization. 
21. Analyzer>Load Setting: Block user from loading setting when sample is at Intro.  When sample is at 

intro, HV is disabled, and won’t be able to ramp DSI supplies. 
22. Load Setting: Display load setting error with red salient on status line. 
 

___________________________________________________________________________ 
 
Release 2.4.0 – October 2016 
___________________________________________________________________________ 
 
OVERVIEW 

SmartSoft-TOF V2.4.0:  Support for new MS/MS and GigE Camera configurations; New Features; Bug Fixing  
 
NEW FEATURES 

UI 



1. Menu Bar>File>Restart TOF-DR: Re-establish communication with TOF-DR when TOF-DR becomes out-
of-sync, hung, or crashed. This frees us from restarting SmartSoft-TOF, which may require shutting 
down of hardware. 

2. Menu Bar>Hardware>System Configuration>MSMS: Support parallel MS and MS/MS data acquisition. 
3. Menu Bar>Hardware>System Configuration>Intro Camera: Support GigE camera. 
4. Menu Bar>Hardware>System Configuration>GCIB: Support GCIB gun configuration.  The 06-2100 has 

three turbo pumps and a magnetic coil.  The 06-2600 has two turbo pumps and a permanent magnet. 
5. Menu Bar>Tools>Sputter Tool>Raster Size (um): Allow editing of raster size of the selected sputter gun. 
6. Menu Bar>Tools>Sputter Tool>Sputter Time: Enter sputter time in seconds. 
7. Menu Bar>Automation>AutoTool>FIB: Support FIB mill/polish tasks. Customers can shut down the FIB 

gun when done and get e-mail notification. 
8. Menu Bar>System>Zip Log Files: Provide a tool to easily zip up system logs, application logs, and 

settings files for problem diagnostics. 
9. Menu Bar>Exit: If acquisition or SED is running, prompt users to confirm exit with shutting down of 

acquisition or SED. 
10. Menu Bar>Sequencer…>Diagnostics…>Sequencer>Save Bulk Data: Save raw bulk data for problem 

diagnostics. 
 
System 
11. Intro Photo>Properties…>Calibrate: The Intro Camera application now includes a simplified point & 

click interface which allows for drawing an area on the intro photo to calibrate the image.  This point & 
click interface is also available to define the clipping area.  Also new is the ability to import a BMP or 
JPEG image from and external camera source (e.g., an external microscope).  This import feature can 
also be used to recalibrate a previous taken intro “.pho” photo file. 

12. Valve Viewer>ToolBar>Large Pressure Display: The large pressure displays are shown in a sizable and 
movable window. 

13. Valve Viewer>GCIB: Show three turbo pumps for 06-2100 and two turbo pumps for 06-2600. 
14. Vacuum>Properties>Intro Ion Gauge: Add support to calibrate ion gauge at atmospheric pressure and 

system pressure. 
 

Sample 
15. Detector>Detector Camera: Add opening and closing of isolation valve (V7). 
16. Position List>Toolbar>Lock Button: A Lock button is added to the position list which, when pressed, 

prevents editing the position list. The Lock button automatically gets pressed when running AutoTool. 
 

TOF 
17. Data Manager>Properties>Filename>Ion Polarity: The auto file naming feature has been expanded to 

include polarity. Use ‘Pos’ for Positive Ions and ‘Neg’ for Negative Ions. 
18. Acquisition Properties: Support additional 64x64 and 128x128 acquisition resolution.  This will speed up 

acquisitions especially for mosaic map.  This feature requires DataAcq model 912 and TDC firmware 
update. 

19. Start Acquisition: Provide an action button to open V7, V8, V11, or V14 if closed. 
20. Spectrum/Profile/Map>Support parallel MS and MS/MS data acquisition for MS/MS equipped system. 
21. Spectrum>Properties>Spectrum>On Complete: Save RAW file at the completion of an acquisition.  This 

can be used to avoid saving unnecessary files during alignment/tweaking/tuning. 
22. Spectrum>Properties>Spectrum>Save Spectrum File: Autosave Spectrum File (.tdc) at the completion 

of an acquisition. 
23. Spectrum>Properties>Spectrum>Save Profile File: Autosave Profile File (.dat) at the completion of an 

acquisition. 
24. Spectrum>Properties>Spectrum>Save Image File: Autosave Image File (.ims) at the completion of an 

acquisition. 
25. Spectrum>Diagnostics>TDC>Threshold:  Set minimum input pulse height accepted. 
26. Profile>Acquisition Status>Charge Comp: Show remaining charge comp time. 



27. Map>Mosaic Area>Maximum Tiles>Specify the maximum number of tiles. 
28. Charge Comp>Ion Neutralize with Gas Gun: Limit settings to neutralize settings. 
29. FIB> Continuously Variable Mill (CVM): Support a new milling process to mill descending slices 

approaching the face of interest like the polish process for better surface integrity. 
30. FIB: Broaden fiducial mark for better visual recognition. 
31. FIB: Integrated to SmartSoft-TOF.  This is a paid feature.  
 
Hardware 
32. Show gun errors for LMIG, C60, GCIB, Cesium, Gas Gun, Ion Neut, E-Neut in a consistent way by using 

red salient in the status bar. 
33. LMIG>PHI LMIG Emitter Status: Show both target and readback values. Add heater resistance 

readback. 
34. Analyzer/MS2>Fix ramping of supplies never complete by adding a 2-minute timeout. 
35. MS2>Properties>Mass Calib: Support viewing and editing of MS2 Mass Calibration parameters. These 

mass calibration parameters are saved in the raw data header. When MS2 spectrum is calibrated 
during acquisition, these parameters are updated in the UI and the raw data header. 

36. Gas Gun>Neutralize: Check the box and _NEUT will be appended to setting name to help differentiating 
neutralize settings from sputter settings. 

37. Gas Gun>Objective Lens: Support wobbling to tune 5-degree bend. 
38. GCIB>Properties>Source>Beam Ramp Rate (kV/sec): Ramp beam voltage slowly when switching to 

Ready mode. 
39. Hardware shutdown/interlock detected>Provide a clear button to clear shutdown or interlock when 

detected.  This includes LMIG vacuum interlock, DSI shutdown and MS2 shutdown. 
 
Others 
40. Use Service-TOF desktop shortcut to run SmartSoft-TOF in service mode.  This means everything is in 

simulation except for SVC and Varian ion gauge. 
 
BUG FIXES 
UI 
41. Menu Bar>Hardware>Bake>Bake Zones: Clean up the bake zone and strip terminology to match 

hardware. 
42. Menu Bar>Tools>Ammeter Tool>Faraday Cup: Do not lower Z and move stage to Faraday Cup position 

if stage is already at the Faraday Cup position. 
43. Menu Bar>Tools>Sputter Tool>Raster Gun/DEM Delay: Remove them as they were not used. 
44. Status Bar>Polarity: Positive (+) Ions/Polarity: Negative (-) Ions: Put up an hourglass to wait for both DSI 

and MS2 Supplies to settle. 
45. Status Bar>Error Message>Display acquisition, vacuum, and sample transfer errors with red salient. 
 
Sample 
46. Stage>Hot Cold: Stop regulating hot cold stage temperature once there are four consecutive sampling 

temperature errors. This is to avoid excessive use of CPU time to catch up temperature sampling. 
47. Stage>Hot Cold: Use backfill intro temperature limits instead of hot/cold warning limits for backfill intro 

temperature check.  
48. Stage>Hot Cold: Remove backfill temperature protection after pump intro is started so users don’t 

need to wait until intro pressure drops below 1.3E-2 Pa. 
49. Stage>Hot Cold>Properties>Relay and Sensor Type: Remove them as they were not used. 
50. Sample Transfer>Extract: Fix the problem of not able to backfill intro after transfer sample close V1 and 

disallow any future vacuum tasks. 
 

TOF 
51. Large raw data file ASCII header: Remove the previous limit of 40K bytes. The symptom was no data 

display. 



52. Data Manager>Playback Raw Data File: Block launching of raw data file playback if acquisition is in 
progress. 

53. Data Manager>LabBook>Comment: Allow editing of comment.  The symptom was no data display in 
playback and the raw data file is corrupted.  

54. Data Manager>LabBook>Filename: The list of invalid characters now includes '~', '_', and '+'.  
SmartSoft-TOF uses '~' when a duplicate filename is found. The complete list of invalid characters is: 
'/\:*?<>|~_+'. 

55. TOF File Editor>Allow editing of ASCII header for raw data files. 
56. Profile>TDC Buffer error>Improve error handling so SmartSoft-TOF doesn’t hang after profile error. 

Depending on the cause of TDC buffer error, software may recover and continue on with the 
acquisition. 

57. Spectrum/Profile/Map>Restart: Disallow restart right after polarity switch. 
58. Spectrum/Profile/Map>Dose: Fix dose calculation. 

 
Hardware 
59. LMIG>Emitter Startup & Shutdown: Improve the robustness so startup and shutdown achieve a higher 

rate of success. Improve error handling. 
60. LMIG>Firmware lock: Limit sampling frequency (emission current and suppressor voltage update) to at 

most once every second to ensure software is responsive.  
61. Au and Ga Emitter Shutdown: Add turning off the heater. 
62. GCIB: With the support of 06-2600, we will skip the control of Magnet Current.  The symptom was 

having “burn fault” and emission current is not set correctly when switching gun mode or load setting. 
63. GCIB: Send down filament current limit when SmartSoft-TOF comes up. This is to ensure the limit is set 

to a known good value. 
64. KnobBox: When the KnobBox is configured but not connected (and not simulated); errors are 

continuously generated in the system log.  This bug will cause the hard drive to fill with log data over the 
course of a few days.  Protection has been added to log only one error in the system log on startup.   

65. WinUSB>Fix crashes at startup if USB devices are disconnected and not simulated. 
 

HELPFUL HINTS 
 

KNOWN ISSUES AND LIMITATIONS 
66. After installing V2.4.0, please run ConfigurationSetup.exe and reselect your Intro Camera option.  

Otherwise, you will get Create Session error.  
 
 
___________________________________________________________________________ 
  
Release 2.2.3 – March 2016 
___________________________________________________________________________ 
 
OVERVIEW 

SmartSoft-TOF V2.2.3:  Bug Fixing  
 

BUG FIXES 
 
Hardware 
1. Hardware>LMIG>Properties>Bi Source: Allow Normal Heat Current (A) to stay as greater than 3.8 A 

after restarting SmartSoft-TOF. 
2. Hardware>GCIB: In load setting or gun mode change, make sure emission current is sent down to 

hardware even if we have a burn fault. Protect the filament from being left on when turning the gun 
mode to off.  

 



___________________________________________________________________________ 
 
Release 2.2.2 – February 2016 
___________________________________________________________________________ 
 
OVERVIEW 

SmartSoft-TOF V2.2.2:  Bug Fixing  
 

BUG FIXES 
System 
1. Vacuum>Properties: Open up the range for Vent Intro to [1E+2, 1.01E+5] Pascal to support using Argon 

for venting. 
 
Hardware 
2. Hardware>LMIG>Properties: Open up the maximum value for Max Heater Current (A) to 4.0 A for Bi. 

 
 
___________________________________________________________________________ 
 
Release 2.2.1 – December 2015 
___________________________________________________________________________ 
 
OVERVIEW 

SmartSoft-TOF V2.2.1:  Adds MS/MS Support (hardware option); New Features; Bug Fixing  
 
NEW FEATURES 

UI 
1. Menu Bar>Tools>System Log: Backup copies of the system log are now stored in the C:\SmartSoft-

TOF\Log directory 
2. Status Bar: The size of the status line fields can now be customized by clicking and dragging the edge of 

the field.  Fields can be returned to their default size by selecting the Reset Default Size option from the 
status line context menu. 
 

System 
3. System>Intro Camera: External image files (.bmp, .jpg) can now be imported and used to navigate on 

the sample.   
 
Hardware 
4. Hardware>LMIG: A new Settings Editor is available for viewing and editing the settings text files.  The 

Settings Editor is accessed through a context menu from the Settings Box.  This Settings Editor is 
available for all hardware applications. 

5. Hardware>Ion Gun: The emission current startup ramping is optimized to improve the lifetime of the 
ionizer. 

6. Menu Bar>Sequencer>LMIG: Fine Delay (250pSec) values are now calculated as a function of coarse 
delay. LMIG: Quad, Buncher; C60: Pulser 2 
 

BUG FIXES 
 
UI 
7. Menu Bar>Hardware>System Configuration>Varian Gauge: The Varian gauge support is working. 
8. Hardware>C60>MVA:  Duplication C60 aperture settings from have been removed from the setting list. 
9. Hardware>Bake>Application Log: Duplicate entries in the Bake application log have been removed. 

 



Sample 
10. Sample>Stage>Hot Cold: Duplicate entries in the H/C Stage application log have been removed. 
11. Spectrum>Properties>Spectrum>Save RAW File On Abort: Data files are now saved when an 

acquisition aborts because of an error. 
 

System 
12. System>Sample Transfer: For protection, the Sample Bias and Immersion Lens are set to 0 V when a 

sample is moved to the intro position; and return to voltage when the sample is moved back to the 
analysis position. 

13. Sample>Sample Transfer: To improve the lifetime of the intro ion gauge, the ion gauge is disabled 
before backfilling intro; and re-enabled during pump intro. 

14. System>Sample Transfer: For protection, the Backfill Intro task now checks that V1 is closed, and that 
stage Z is at positive limit. 

15. Sample>Intro Camera: Communication reliability with Canon camera has been improved.  
 

Hardware 
16. Hardware>C60: Communication problems with the C-863 MVA aperture have been fixed. 
17. Hardware>C60: User ranges are read from the controller instead of using hardcoded manufacturer 

numbers. The effect is we do better calculate in converting between DAC numbers and user values. 
Also updated the calibration offsets so the read backs matched those from the manufacturer. 

18. Hardware>GCIB:  Tilt x, tilt y, rotation, and raster size calibration factors are now included in the GCIB 
settings.  Previous these values were properties. 

19. Hardware>GCIB: Baud rate for PHI GCIB control must be set to 9600.  The baud rate is now correctly set 
when this configuration is changed. 

20. Hardware>E-Neut: The E-Neut extractor voltage range is changed from [10, 75] V to [0, 75] V. 
21. Hardware>LMIG: Lens1 and Lens2 now use wobbling support found in the firmware; this is identical to 

what was done in previous version of WinCadence software. 
22. Hardware>LMIG>Properties>Raster: Mass Calibration Intercept field is difficult to edit because the field 

is displayed in scientific notation.  This has been fixed. 
23. Hardware>LMIG>Source Properties>Lock: Refresh Rate field is no longer used and has been removed. 
24. Hardware>LMIG>Schematic: LMIG labels for X and Y steering plates have been corrected.  These labels 

were inverted. 
25. Hardware>LMIG>Diagnostics: a 20-751 read back value was added for Extractor Limit DAC 
26. Analyzer>Spectrometer: the Post ESA Blanker value is now correctly set when in DC mode. 
27. Hardware>I-Neut:  I-Neut is now blanked when switching from DC mode to Ready/Off mode.  Previously 

the bias voltage was set to 0.0, however this method did not effectively blank the beam. Gun is un-
blanked when going back to DC mode. 

 
HELPFUL HINTS  
 
KNOWN ISSUES AND LIMITATIONS 
1. TOF>Spectrum: Acquisition appears to be running but nothing is displayed in TOF-DR.   

a) This problem is typically associated with a large raw data file ASCII header.  This should be verified by 
examining the file header in a WordPad style editor.  A fix is included in V2.2.1, which minimizes this 
problem. 

___________________________________________________________________________ 
 
Release 2.1.0 – February 2015 
___________________________________________________________________________ 
 
OVERVIEW 

SmartSoft-TOF V2.1.0:  20kV-C60 Ion Gun Supported as Primary Gun; Bug Fixing 
 



NEW FEATURES 
1. Menu Bar>System>E-Mail Notification: An e-mail or text message notification can be sent at the completion 

of an acquisition or AutoTool sequence.  Multiple notifications can be added to the AutoTool sequence to 
track the progress of the sequence.  Notifications can be sent to multiple e-mail addresses. 

2. Menu Bar>System>Coffee Timer: AutoTool tasks can be scheduled to begin processing at a specified day 
and time.  

3. Hardware>LMIG: LMIG 20-751 - The suppressor range for the 20-751 LMIG control is changed from (-2000.0, 
0.0) to (0.0, 2500.0).   This change is designed to improve the stability of the emission current during a long 
acquisition.   

4. Hardware>20kVC60: The 20kV-C60 ion gun is now fully supported as the primary ion gun. 
 
 
HELPFUL HINTS 
1. Entry fields must be 'terminated' either by selecting the <Enter> key or by moving to another parameter field.  

If the application is exited before the value is terminated the change will not be saved. 
            
KNOWN ISSUES AND LIMITATIONS 
 
___________________________________________________________________________ 
 
Release 2.0.0 – October 2014 
___________________________________________________________________________ 
 
OVERVIEW 

SmartSoft-TOF V2.0.0: Represent an extensive rework of the instrument control software for the nanoTOF II 
system.  This version is built using the SmartSoft architecture and implements many of the capabilities 
found in other SmartSoft products. 
 
For flexibility the data reduction software, TOF-DR, has been split from the instrument control software.  
This allows for efficient data reduction using TOF-DR on an off-line computer.  On the instrument TOF-DR 
communicates directly with SmartSoft-TOF to display the data real-time.  Real-time data displayed in TOF-
DR can be easily manipulated during data collection with no limitations.  

 
HELPFUL HINTS 
1. Entry fields must be 'terminated' either by selecting the <Enter> key or by moving to another parameter field.  

If the application is exited before the value is terminated the change will not be saved. 
            
KNOWN ISSUES AND LIMITATIONS 
            
 


